# Table of Contents

TABLE OF CONTENTS ........................................................................................................... 1

PREFACE ................................................................................................................................. 3

SYSTEM REQUIREMENTS ......................................................................................................... 4

   LICENSING ........................................................................................................................... 4

INSTALLATION ......................................................................................................................... 5

   FLIR SMART VEHICLE SEARCH PLUGIN INSTALLATION .................................................. 5

ARCHITECTURE ....................................................................................................................... 6

ADMINCENTER CONFIGURATION .............................................................................................. 7

   ADDING A SMART VEHICLE SEARCH SERVER ................................................................. 7

   SMART VEHICLE SEARCH SETTINGS .............................................................................. 8

   CAMERA SELECTION .......................................................................................................... 9

   STOPPING AND STARTING THE SMART VEHICLE SEARCH SERVER ......................... 10

   CONFIGURING LATITUDE RESPONSES TO SMART VEHICLE SEARCH EVENTS .... 11

   ALARM-TYPES AND PLUGIN-EVENTS ................................................................................ 13

   CAMERA REGION OF INTEREST (ROI) CONFIGURATION ............................................... 16

   TRANSCODER SETTINGS ................................................................................................... 17

   USER PRIVILEGES ............................................................................................................. 18

SUPPORTED COUNTRIES ......................................................................................................... 19

   COUNTRY CLASSIFIER CONFIGURATION ....................................................................... 19

CONTROLCENTER USAGE ......................................................................................................... 20

   SMART VEHICLE SEARCH BOOKMARK QUERY .............................................................. 21

   METADATA OSD ................................................................................................................ 22

   CONTROLCENTER OSD SETTINGS .................................................................................... 22

   ENABLE/DISABLE METADATA OSD WITHIN SELECTED TILE ..................................... 22

OPTIMIZE IMAGE ACQUISITION FOR LPR ............................................................................. 23

   DEPLOYMENT BEST PRACTICES ......................................................................................... 23

   CAMERA SETUP ............................................................................................................... 26

       Estimating the Maximum Exposure Time .................................................................... 27

       Limiting Exposure Time and Cameras Analog Gain .................................................... 28

       Using External IR Illumination ........................................................................................ 28

UNINSTALLING ......................................................................................................................... 29

UPGRADING .............................................................................................................................. 30

   UPGRADING LATITUDE .................................................................................................... 30

   UPGRADING FLIR-SMART VEHICLE SEARCH MODULE .............................................. 30

LIMITATIONS ......................................................................................................................... 31

TROUBLESHOOTING ................................................................................................................. 32

   LOG FILES .......................................................................................................................... 32

   KNOWN ISSUES ................................................................................................................. 32
Preface

Smart Vehicle Search™ (SVS) is an enhancement to FLIR’s Latitude VMS, allowing the ability to query for recorded video footage using license plate numbers, captured by IP cameras managed by the VMS. With Smart Vehicle Search any IP camera can become an LPR sensor, utilizing Neural Networks on the FLIR Cloud, trained to efficiently detect and recognize license plate numbers within high volumes of video.

Any camera configured in the FLIR Latitude VMS can be utilized by Smart Vehicle Search. The total number of cameras that can be deployed per system is determined according to the number of Smart Vehicle Search channels activated for the Latitude VMS license. AdminCenter users can select the desired cameras as well as define the region of interest in each of the field of views. Once configured, the associated video streams will continuously upload to the FLIR Cloud, where they will be analyzed by the AI engine for license plate recognition (LPR). Each recognition will be sent back to the VMS which will automatically bookmark the associated video footage with the license plate information.

As a result, VMS operators can search for specific vehicles within the VMS video archive and retrieve results for the associated footage, using either full or partial license plate details in the search query.

This document outlines the way to install and configure Latitude with the Smart Vehicle Search module.

For additional configuration information - such as firewall settings, entity creation and more, please refer to the Latitude installation guide.
**System Requirements**

Before installing the FLIR Smart Vehicle Search analytics module, please verify that:

1. You have a fully configured Latitude 8.0 (with LU 8.0.3.6113 or above)\(^{(1)}\) with an Application Server and Transcoder added and setup
2. Microsoft .NET Framework 4.7.2 is installed on the Application Server machine
3. Firewall settings for the Application Server machine must allow for both outgoing HTTPS and WSS protocol communication to the FLIR cloud server listening at port 443.
   a. The module will communicate via secure TLS encrypted endpoints that are generated dynamically for each channel to the “cloud.flir” domain + top-level domain over both HTTPS and WSS.
   b. For example, the following are possible endpoint formats the Application Server must be able to communicate with:
      - `wss://prod-lambda-prism.cloud.flir/api/prism/jobs/stream/example1`
      - `https://lambda.cloud.flir/api/example2`
4. AdminCenter/ControlCenter clients and Archiver machines (that manage cameras that will use this solution) must be able to establish outgoing communication to the Application Server listening at port 54321.

Note:
\(^{(1)}\) – Please contact FLIR’s Latitude VMS Support Group (Product.Enterprise.Support@flir.com) to inquire about specific versions compatibility between Latitude & the relevant Smart Vehicle Search plugin version.

**Licensing**

The solution requires an available **Smart vehicle search channel** license per each concurrently enabled analytics camera.
Installation

The FLIR Smart Vehicle Search module is a Latitude plugin that runs within various Latitude processes:
- AdminCenter
- Directory
- Archiver (AM/ART)
- Application Server

FLIR Smart Vehicle Search Plugin Installation

The Smart Vehicle Search plugin must be installed on the following machines:
- All AdminCenter and ControlCenter client machines
- All Directory machines (primary and failover)
- All Archiver machines (primary and failover)
- All Application Server machines (primary and failover)

Note: If you do not install the plugin on the failover Directory, Archiver or Application Server machines, SVS will not work properly once Directory, Archiver or Application Server failovers occur.

To install the plugin, follow these steps:
1. Make sure that all Latitude processes (services and clients) are not running on the machine.
2. Run the provided plugin installer FLIR.SmartVehicleSearchPlugin.msi
   a. Note: Microsoft’s User Account Control (UAC) setting may prevent MSIs from running successfully unless they are explicitly executed as an administrator. In such cases, open a Command Prompt as Administrator, and run the MSI from the command prompt.
3. Follow the on-screen instructions.
4. Restart all Latitude services and client processes running on the machine where you just installed the SVS plugin module.
Architecture

The FLIR Smart Vehicle Search utilizes Latitude’s plug-in technology and incorporates Application Server, Directory, Metadata and AdminCenter plug-ins. The architecture consists of the following components:

1. **Application Server Plugin** is responsible for:
   a. Establishing a client connection with the FLIR Cloud
   b. Acquiring VMS video streams from the **Transcoder** and proxying over Websocket Secure to FLIR Cloud
   c. Receiving license plate recognition (LPR) events from FLIR Cloud and:
      i. Distributing plate recognition events as VMS event for the camera
      ii. Distributing metadata OSD for all recognition frames

2. **Directory Plugin** is responsible for:
   a. Monitoring the accessibility of the Application Server
   b. Creating alarm/event types for the Smart Vehicle Search plugin

3. **AdminCenter Plugin** enables users to:
   a. Add a Smart Vehicle Search server representation in the Physical View of AdminCenter
   b. Configure user credentials for communication with the FLIR Cloud
   c. Select cameras that LPR will be performed for
   d. Configure a license plate watchlist
   e. Configure regions of interest that will be sent to the FLIR Cloud recognition engine
   f. Configure Latitude actions for incoming LPR events and alarms

4. **Metadata Plugin** is responsible for:
   a. Processing of metadata events received from the Smart Vehicle Search server
   b. Metadata sources are initialized in the ART for unicast and recorded video streams or in the clients (i.e. AdminCenter / ControlCenter) for multicast streams.

![Figure 1: Architecture](image)
AdminCenter Configuration

Adding a Smart Vehicle Search server

To allow for Latitude components to receive incoming events from the FLIR Cloud Smart Vehicle Search server, first verify that an Application Server has been added and configured in the system.

Next, add a representation of the FLIR Cloud Smart Vehicle Search server to Latitude’s Physical tree by navigating to the Physical tree, right-clicking the System node and selecting “Add Smart Vehicle Search server”.

![Figure 2: Adding the Smart Vehicle Search server](image)

A new Smart Vehicle Search server node is added to the tree and a configuration workspace will show on the right.

Note: Only one Smart Vehicle Search server can be added to a Latitude system.
Smart Vehicle Search Settings

Within the Smart Vehicle Search Settings section of the server’s General tab administrators must enter the FLIR Cloud user credentials in addition to a couple additional configuration items that will be covered below.

In order to sign up for an account for the very first time, administrators can press the Register button, and enter the required fields for an initial registration. Upon pressing OK, a confirmation email will be sent to the provided email address. The newly registered email account must be verified by clicking the Verify link in the body of the welcome email.

Once the initial FLIR Cloud user account registration is complete, the FLIR Cloud email Username and Password credentials should be entered into the relevant fields as seen in the below screenshot:

![Figure 3: Smart Vehicle Search server General tab](image)

Additional settings that can be configured in this section include:

- **Create incident/bookmark upon event**: When enabled, the module will create an incident/bookmark upon incoming LPR events including the plate number, that can be later queried for

- **Create OSD**: When enabled, the module will create metadata On Screen Display with license plate data over live video frames. Since this feature is susceptible to network latency (vs bookmarks which are added to recorded video based on timestamps), users may wish to disable this feature when latency with the FLIR Cloud is too great for the speed of traffic over live streams

Once the Smart Vehicle Search settings are saved, the Latitude module, i.e. Application Server, will authenticate with the FLIR cloud, and the server will appear as online in the Physical tree.
Camera Selection

To select cameras to be treated as analytics cameras (performing license plate recognition) move a camera from the “Available Cameras” list to the “Analytics Cameras” list.

Double clicking a camera, or selecting the “>”/“<” buttons will move a single camera from one side to another. The “>>”/“<<” buttons will move all cameras from one side to another.

Upon saving your changes, a corresponding alarm type will automatically be created for each selected camera.

Notes:
1. Upon deselection of an analytics camera, the corresponding alarm type will not be automatically deleted.
2. When the parent Smart Vehicle Search server is removed from the AdminCenter Physical tree, all associated Alarm Types will be removed along with the parent.
Stopping and Starting the Smart Vehicle Search Server

Latitude can stop sending video to the FLIR Cloud for processing and receiving Smart Vehicle Search events for all selected cameras by right-clicking the Smart Vehicle Search server node and selecting “Stop Server”. To resume sending live video for license plate recognition processing and listening to incoming events, right-click the node a second time and select “Start Server”.

Figure 5: Stop and Start the Smart Vehicle Search server
Configuring Latitude Responses to Smart Vehicle Search Events

Browse to the “Alarms and Events” tab of the Smart Vehicle Search server entity to configure Latitude’s global response behavior to Smart Vehicle Search license plate recognition event types (see Figure 6).

The module supports the following types of events on cameras that can be handled by Latitude:

<table>
<thead>
<tr>
<th>ID</th>
<th>Smart Vehicle Search Camera Event Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>101</td>
<td>Smart Vehicle Search – Analytics lost</td>
</tr>
<tr>
<td>102</td>
<td>Smart Vehicle Search – Analytics recovered</td>
</tr>
<tr>
<td>103</td>
<td>Smart Vehicle Search – Plate recognized</td>
</tr>
<tr>
<td>104</td>
<td>Smart Vehicle Search – Plate in watchlist</td>
</tr>
</tbody>
</table>

Using the Alarms and Events widget, the user can set one of four global Latitude responses:

1. **Treat as Latitude Alarm**: The automatically created alarm types for Selected Cameras will be triggered.
2. **Treat as a Latitude Event**: Dispatches the corresponding plugin event for the camera.
3. **Treat in Runtime**: The incoming event will be treated by both triggering an alarm and dispatching the corresponding plugin event.
4. **Ignore Event**: The incoming event will be ignored altogether.

You can either check the individual radio-buttons to define a different behavior for each event type or you can check the radio-button of a parent node to automatically check all children nodes.
In Figure 7 below, the Alarm response was clicked for the root node (Events), setting the Latitude response to “Treat as Latitude Alarm” for all children nodes.

![Figure 7: Treat all events as Latitude alarms](image)

After each change, the Save button becomes enabled. Click it to save your changes.
Alarm-Types and Plugin-Events

For each Latitude camera selected as a Smart Vehicle Search enabled Camera, SVS will automatically create an associated Alarm Type under the System Settings tree (see Figure 8) and associate the camera by adding it to the alarm type’s Cameras tab.

In addition, SVS will create plug-in events for the main Smart Vehicle Search server appearing under the entity’s “Actions” tab (see Figure 9) and for the cameras selected as Analytics Cameras under each camera’s “Actions” tab (see Figure 10).

License plate recognition events received at the SVS module are handled based on the configured Latitude Response for cameras selected as Analytics Cameras:

1. **Alarm type**: automatically created per camera and triggered when an analytics event is received and the response is set to “Treat as Latitude Alarm” (or “Treat in Runtime”).
2. **Plug-in event**: dispatched whenever a Smart Vehicle Search event is received in Latitude and the Alarm and Events response is set to “Treat as Latitude Event” (or “Treat in Runtime”).

Once identified, the SVS module triggers the corresponding camera’s alarm type or dispatches the corresponding plug-in event.

![Figure 8: Alarm types automatically created by SVS](image-url)
Smart Vehicle Search plugin events are added to all selected cameras acting as Analytics Cameras. While the event names appearing in the below screenshot require scrolling to be viewed in full, the event names are listed here.

**Notes:**
1. For incoming events that are set to “Ignore” in the Alarms and Events tab, the module will neither trigger an alarm nor dispatch an event.
Using Latitude’s Events/Actions infrastructure, the AdminCenter user can further configure actions to be executed alongside the alarm or event. For example, in Figure 11 below, a “Start Recording” action is configured for the **Smart Vehicle Search – Plate recognized** plug-in event associated to an analytics camera.

![Figure 11: Start Recording Action for Smart Vehicle Search – Plate recognized Event of Analytics Camera](image-url)
Camera Region of Interest (ROI) Configuration

All cameras selected to be treated as analytics cameras (performing license plate recognition) by the Smart Vehicle Search plugin will have a new tab added to their AdminCenter configuration tabs called LPR. Upon navigating to the LPR tab, administrators can modify the Region of Interest (ROI) that will be processed by the plugin module for that camera.

The plugin component currently enforces a maximum resolution of VGA (640x480 pixels) for the configured region of interest within a given camera’s field-of-view in order to optimize processing times and reduce bandwidth of data sent to the FLIR Cloud. This resolution is based on the resolution configured for the Transcoded stream configured for the applicable Transcoder server (rather than the camera’s Live video settings).

To modify the camera’s region of interest, move the View → Edit selector at the top left section of the page to Edit, press the square icon, then manually change the shape and location to the desired region of interest:

![Figure 12: Configuring Region of Interest for Cameras under LPR Tab](image)

Once done setting the region of interest, press the save icon at the top right section of the page for the new setting to apply. Note that if the configured region exceeds VGA resolution, the plugin module will resize the selection area to keep within the supported maximum resolution.
Transcoder Settings

Smart Vehicle Search acquires live video streams from the Latitude Transcoder server. Under the Transcoder server’s General tab, the Transcoded stream configuration section includes a few settings that are applicable for this plugin module:

![Transcoder’s Transcoded Stream Configuration](image)

**Figure 13: Transcoder’s Transcoded Stream Configuration**

Note that the “Maximum frame rate” must not exceed 5 frames per second, in order to be able to achieve a reliable handling of recognition results. Any value greater than 5 may impact performance and would require restoring the setting back to 5fps.

Administrators should feel free to adjust the other settings (as documented in the Latitude help files) based on any other considerations. Adjusting the “Maximum resolution” will impact the potential maximum size of the region of interest set for cameras. For example, if this is set to “480p”, the defined region of interest set for the camera can be increased to include the camera’s complete field of view (since it is within the maximum VGA resolution enforced).

Note however, that there must be enough pixels on target with the new resolution setting for recognitions to be possible over the video frames. Reducing a camera’s resolution to 480p while mounted at a distance from traffic, would cause the plates to not be recognizable by the human eye, as well as the LPR recognition engine. In general, a higher resolution (i.e. 1080p or “Same as original”), while working against the VGA region of interest will typically yield the best results.

“Compression” settings can set to either MJPEG or H264. The plugin module will always request a MJPEG from the Transcoder regardless to this global setting.
User Privileges

In order to allow a user other than the Administrator to use SVS, the following steps must be conducted for the selected user within the user’s Privileges tab in AdminCenter:

Select the Plugins and Integrations node and check the Allow radio button for the parent Plugins and Integration node:

Figure 14: Software Component Privileges
Supported Countries

The following table lists all currently supported countries, with their relevant classifier country code configuration:

<table>
<thead>
<tr>
<th>Country code</th>
<th>Countries supported</th>
</tr>
</thead>
<tbody>
<tr>
<td>usa</td>
<td>USA - all states - best quality in: CA, CO, FL, IN, KS, MT, NY, TX + support for stacked characters</td>
</tr>
<tr>
<td>eu</td>
<td>West Europe Classifier. States: Austria, Belgium, Bulgaria, Czech Republic, France, Germany, Hungary, Italy, Latvia, Lithuania, Luxembourg, Netherlands, Norway, Poland, Romania, Slovakia, Spain, Sweden, Switzerland, Turkey, Ukraine</td>
</tr>
<tr>
<td>eu_extended</td>
<td>Extended West Europe Classifier. States: Austria, Belarus, Belgium, Bulgaria, Croatia, Czech Republic, Estonia, France, Germany, Hungary, Italy, Latvia, Lithuania, Luxembourg, Montenegro, Netherlands, Poland, Portugal, Romania, Serbia, Slovakia, Slovenia, Spain, Switzerland, Turkey, Ukraine, United Kingdom</td>
</tr>
<tr>
<td>eu_north</td>
<td>North Europe Classifier. States: Finland, Norway, Sweden</td>
</tr>
<tr>
<td>au</td>
<td>Australia - Australian Capital Territory, Australia - New South Wales, Australia - Queensland, Australia - South Australia, Australia - Victoria, Australia - Western Australia</td>
</tr>
<tr>
<td>br</td>
<td>Brazil</td>
</tr>
<tr>
<td>ca</td>
<td>Canada</td>
</tr>
<tr>
<td>eg</td>
<td>Egypt</td>
</tr>
<tr>
<td>gulf</td>
<td>United Arab Emirates - Abu Dhabi, United Arab Emirates - Ajman, United Arab Emirates - Al Fujayrah, United Arab Emirates - Ash Shariqah, United Arab Emirates - Dubai, Saudi Arabia, Bahrain, Kuwait, Oman, Qatar</td>
</tr>
<tr>
<td>mx</td>
<td>Mexico</td>
</tr>
<tr>
<td>nz</td>
<td>New Zealand</td>
</tr>
<tr>
<td>pe</td>
<td>Peru</td>
</tr>
<tr>
<td>sg_my</td>
<td>Malaysia, Singapore</td>
</tr>
<tr>
<td>th</td>
<td>Thailand including provinces recognition</td>
</tr>
<tr>
<td>tw</td>
<td>Taiwan</td>
</tr>
<tr>
<td>za</td>
<td>South Africa</td>
</tr>
</tbody>
</table>

Country Classifier Configuration

In order to configure the plugin to work with a different country than the default “usa”, administrators will need to perform the following configuration change:

On the Application Server machine, navigate to the VMS installation’s Smart Vehicle Search Plugin path (typically: C:\Program Files (x86)\FLIR\Latitude\Plugins\SmartVehicleSearch). Under this path locate a SmartVehicleSearch.config.xml file. Within this file, a <Classifier> tag appears that has the following default value:

```
<Classifier>usa/lpr.ini</Classifier>
```

To change the effective country that Smart Vehicle Search should perform recognitions for, replace the country code, with the appropriate value from the table above leaving the “/lpr.ini” suffix. Save your change, then restart the Application Server. For example, to begin performing recognitions for North Europe license plates, the relevant configuration should be changed to:

```
<Classifier>eu_north/lpr.ini</Classifier>
```

Note: Only changes to the Classifier tag for the purpose of working against the relevant country is supported. All other settings in this file are for internal use only and must remain at their default values for normal operations.
ControlCenter Usage

Upon incoming license plate recognitions over live video, the Smart Vehicle Search plugin module can be configured to dispatch plugin events (or trigger alarms), as well as add On Screen Display (OSD) to video with the recognized plate number. In addition, an incident/bookmark may also be configured to be created for license plate reads.

As a result, operators in ControlCenter may review live video streams for the relevant selected cameras that include license plate metadata OSD, as well as review recorded clips that include the LPR metadata OSD and bookmarks added when the live stream was recorded.

In the screenshot below, we can see an example of a live video stream (on the left tile), while playback from that scene is presented (on the right tile).

![Figure 15: ControlCenter Presenting LPR Recognitions over Live and Playback](image-url)
Smart Vehicle Search Bookmark Query

ControlCenter operators can perform searches for recorded video clips, given either a complete license plate number or a partial one. To perform a bookmark query in ControlCenter, operators must navigate to the Query tab at the bottom left panel and select to Search for: “Bookmark”.

Within the Text search field, operators may either enter a complete license plate number or a substring that is included within the plate searched for.

After selecting the relevant cameras and the applicable Data and Time to search and pressing the Go button, ControlCenter will present matching results in the Query Results pane. Double-clicking the results will bring up the associated clip to a ControlCenter tile as can be seen in the screenshot below:

![Figure 16: ControlCenter Presenting Bookmark Query Results](image)

**Figure 16**: ControlCenter Presenting Bookmark Query Results
Metadata OSD

Upon receiving license plate recognition event events while Create OSD is enabled for the Smart Vehicle Search server, the plugin module will display the metadata as OSD objects on cameras configured as “Analytics Cameras”.

ControlCenter OSD Settings

Metadata OSD display settings can be configured within ControlCenter by navigating to Tools → Options. From the Options dialog, expand the View Settings → OSD node to display the configurable “Metadata general” settings.

From the “Metadata general” Options settings dialog (see Figure 17 below), users can select to “Show metadata OSD” and configure the metadata OSD shape opacity.

![Figure 17: “Metadata general” ControlCenter settings](image)

Enable/Disable Metadata OSD within selected Tile

When “Show metadata OSD” is selected under Tools → Options → OSD → ”Metadata general”, an “Analytics Camera” displayed in a ControlCenter tile will be set by default to “Enable Metadata OSD”.

In order to enable/disable Metadata OSD display within a selected tile, right-click the tile and select/deselect the “Enable Metadata OSD” option:

![Figure 18: Enable/Disable Metadata OSD in ControlCenter tile](image)
Optimize Image Acquisition for LPR

This section describes how image acquisition should be set up in order to achieve good reading results with the Smart Vehicle Search LPR engine. It is relevant for all users who deploy and use cameras in the field.

For the best possible reading results, images taken with a camera need to adhere to certain minimum standards. Achieving a reasonable image quality is sometimes not trivial and a careful consideration of the installation must include:

- Illumination conditions at the location
- Required sensor resolution
- Imaging geometry in general (camera position)
- Viewing angles
- Exposure times
- Gain settings
- Aperture settings of the lenses used

This section explains those factors and provides useful tips on how to set up a camera so that Smart Vehicle Search can achieve the best possible reading results.

Deployment Best Practices

The mounting position and viewing angle of your camera define the imaging geometry relative to the expected location of license plates.

Geometric factors which influence the image of the license plates are:

- Distance to the expected plate location
- The focal length of the lens
- Side viewing angle
- Vertical viewing angle
The following figure depicts those parameters graphically. The figure also defines our recommended maximum values for the viewing angles. The aspect angle of the camera relative to the car backside or front side (sideways viewing angle) shall not exceed 30° left or right. It will be possible to read at greater viewing angles but expect to get worse reading results in this case.

![Figure 19: Maximum Viewing Angles](image1)

The angle from the plate middle point to the camera should not exceed 30° in any direction.

Vertical viewing limits should be in the range of 30 degrees below and not more than 30 degrees above the license plate.

The horizontal viewing limits, which should be in the range of +/-30 degrees around the center of the license plate.

The projection of a license plate into the image creates a rotation on the image plane, as shown in the following image. This rotation should not exceed more than 20 degrees relative to the x axis (the horizontal axis) of the image.

![Figure 20: In-plane image rotation](image2)

The angle of a license plate should not exceed 20 degrees in either angle relative to the horizontal image axis. In the image above, the rotation is approximately 20 degrees.
Aside from the viewing angles, the combination of:

- Sensor resolution
- Distance
- And focal length

of the imaging system defines the size of the license plate in an image.

We recommend to setup the camera so that the characters of the license plate have a minimum size of 12 px. Smart Vehicle Search can read character sizes down to 8 px well, but this depends on the overall image quality. In addition, the overall size of an LP resolution should allow a gap of at least 1 px between adjacent characters in the license plate.

The maximum height of characters in an image should not exceed 150 pixels. Larger character sizes are not recommended.

In practice, a typical setup would image the width of a car at about 300 pixels (independent of the camera resolution!). For example, for images with VGA resolution (640x480 px) the width of a car should be at least around half the image width. The following figure gives an example of the character size recommendations:

![Character Sizes and Recommended Limits](image)

**Figure 21:** Character Sizes and Recommended Limits

Note: The projection of license plates into an image as a result of viewing angle and license plate location can create an artificial rotation.
Camera Setup

Taking control of the camera with respect to the imaging sensor is most important when it comes to obtaining good image quality day and night, under all possible illumination conditions.

A camera in an outdoor environment or close to that (e.g. the exit of a parking garage) is subject to harsh illumination from the Sun which might create reflections or from headlights of cars which may beam directly into the camera which is mounted at the gate.

Under all conditions, images should be sharp, with minimal motion blur, and of proper exposure. The license plates should not be overexposed at all - if you must make a choice, it is better to have slightly darker images than too bright ones.

As a general recommendation, the following exposure (= shutter) times are advised:

- A shutter time of 0.1-3 ms on highways, for high speed vehicles
- A shutter time of 0.1-3 ms in urban areas, for medium speed vehicles
- A shutter time of 1-20 ms in parking situations, for slow vehicles.

In the following two example images, we see an overexposed image vs a slightly underexposed image:

![Overexposed Image](image-url)

Figure 22: Overexposed Image
It is better to produce slightly underexposed images than overexposed images.

**Estimating the Maximum Exposure Time**

The maximum possible exposure time can be calculated from the viewing geometry and image resolution. The basic principle is that a vehicle should not move more than 1 px in the image during the exposure time at the maximum possible speed.

It is possible to either compute this value exactly using measurements of the visible street section, viewing angles, etc. or it can be approximated. By measuring the time $T$ it takes a vehicle from top to bottom, or left to right of an image - whatever time is shorter - and the image resolution in this direction (i.e. number of pixels), the maximum allowed exposure time in ms can be computed as follows:

$$exposureTime(ms) = 1000 \times \frac{T}{\text{resolution}}$$

*Hint:*
An average image brightness between 120-180 gray values is a good starting point for the overall image brightness.

The last important factor that affects image quality is the gain setting on your camera. The gain affects the sensitivity of your camera and it may be dynamic or not, depending on the camera’s brand and model.

The higher the gain, the grainier the images become, and LPR will become harder. The limits of gain depend on the device, reasonable upper limits are typically 6-10 dB.
Limiting Exposure Time and Cameras Analog Gain

A typical configuration benefiting LPR would be to limit the allowed exposure time and gain setting on the camera so as not to create blurred or noisy images. This can be achieved by enforcing a shutter and gain limit in the camera configuration either programmatically from the camera driver, or in the camera configuration dialog if the camera model provides software for this purpose.

For many IP camera models, it is not possible to directly control shutter and gain limits for proper automatic exposure. Some camera models allow parameter settings over the HTTP protocol, but this process is slow and not suitable for proper control in many application scenarios.

Using External IR Illumination

To achieve the best possible image quality, we recommend using external IR illumination in combination with IR bandpass filters on the camera.

A recommended setup would be to use IR LEDs at a wavelength of 850 nm and a matching bandpass filter on the camera objective, which could either have a wavelength window of 720-850 nm or could be centered around 850 nm. Using a wider bandpass filter results in better imaging of the environment, a narrow bandpass filter results in a much better contrast of the LP relative to the background.

The external illumination combined with the filter reduces the effects of the glare from the sun or the headlights from cars very efficiently. In combination with a wider filter, it still allows daylight to pass so that the environment can be imaged as well.
Uninstalling

To uninstall the plugin, follow the steps below:

1. Make sure that there are no open Smart Vehicle Search alarms in ControlCenter.
2. In AdminCenter under the Physical tree, remove the Smart Vehicle Search server entity.
4. In Windows Control Panel, double-click “Add or Remove Programs”.
5. Locate the “FLIR-Smart Vehicle Search Plugin” entry and select Remove.
6. Restart the Latitude services and applications.
7. Repeat for AdminCenter and ControlCenter machines where SVS was installed.

Note: Be sure to conduct step (1) before uninstalling the plugin from Add Remove Programs to ensure that all entities created by the plugin module are properly removed.
Upgrading

Upgrading Latitude

When upgrading Latitude with a Latitude Update in the same major release (e.g. Latitude 8.0 GA to Latitude 8.0 LUxx, or 8.0 LUxx to 8.0 LUyy), there is no need to perform any special procedure. The FLIR Smart Vehicle Search module will work after upgrading the Latitude version.

When upgrading Latitude from one major release to another (e.g. Latitude 8.0 to Latitude 9.0), please contact FLIR to inquire about a version of the FLIR Smart Vehicle Search module that is compatible with the new Latitude NVMS system.

If a new version of the plugin is required for the new Latitude system, please perform the following instructions for upgrading the FLIR-Smart Vehicle Search module.

Upgrading FLIR-Smart Vehicle Search module

To upgrade SVS from a previous version:

1. Stop all Latitude services and client processes running on the machine where you would like to upgrade the plugin module (keeping all existing configuration in the system as-is).
2. In Windows Control Panel, double-click “Add or Remove Programs”.
3. Locate the “FLIR-Smart Vehicle Search Plugin” entry and select Remove.
4. Conduct a new installation as described in the Installation section above after removing the previous plugin version.
Limitations

1. License plate metadata on screen display (OSD) over live video frames is susceptible to network latency (as opposed to bookmarks which are added to recorded video based on timestamps). Users may wish to disable the Create OSD feature when latency with the FLIR Cloud is too great for the speed of traffic over live streams.

2. The Maximum region of interest per camera is currently limited to VGA resolution (640x480).

3. The Maximum Frame Rate set in the Transcoder service must not exceed 5fps.

4. No OSD data is exported to AVI when an export is conducted in Latitude.

5. Multiple events set to be treated as alarms will only be triggered after that specific alarm type’s Rearm limit has passed since the previous alarm was triggered. It should be possible to view whether any additional event has occurred within this Rearm limit, by navigating to the ControlCenter Events Pane. Note, that in order to receive both alarms and events for Smart Vehicle Search server /camera events, the event type should be set to “Treat in Runtime” in the Smart Vehicle Search server’s Alarms and Events configuration tab in AdminCenter.

6. A single Smart Vehicle Search server will be supported per Latitude system (Directory).

7. Only a single Smart Vehicle Search server will be fully supported across multiple Latitude systems (Directories). For example: If different Smart Vehicle Search servers are defined in multiple Directories, a ControlCenter client logged into multiple Directories will only present metadata OSD for multicasting cameras in the Directory last logged into within a ControlCenter tile.

8. FLIR is not responsible for the quality of analytics information coming from the License Plate Recognition analytics server.
Troubleshooting

Log Files

The Smart Vehicle Search module prints out log files for Latitude services and clients. Should you require troubleshooting an issue, please have the following log files (with file tracing set to Debug) ready with a timestamp of the reported issue:

- AdminCenter/ControlCenter log files
- Application Server log files
- Directory log files
- Archiver (AM/ART) log files
- Transcoder log files

Known Issues

Below are a number of potential common issues that may be encountered and their associated resolutions:

<table>
<thead>
<tr>
<th>Issue</th>
<th>Resolution</th>
</tr>
</thead>
</table>
| Smart Vehicle Search server representation in the Physical tree appears offline | Confirm that:  
1. An Application Server is defined in Latitude, and is currently accessible.  
2. If the Smart Vehicle Search server has been stopped, right-click the server node in the Physical tree and select “Start”  
Also verify resolution steps mentioned for “Smart Vehicle Search events are not received in Latitude” |
| Smart Vehicle Search events are not received in Latitude | 1. Confirm that the plugin module was installed on an Application Server that is configured in Latitude and that it is running on a machine that has internet connectivity.  
2. Confirm that the Username entered for the Smart Vehicle Search Settings is a valid email address (that was already verified via a welcome email), and that the Password entered is correct.  
3. Confirm that |
| Metadata OSD does not appear in ControlCenter for a camera scene displayed in a tile. | Confirm that:  
1. The plugin module was installed on the Directory, Archivers, Application Server and client machines, and Latitude services and clients were restarted following installation. Refer steps in Installation section.  
2. Check AdminCenter configuration  
   • A Smart Vehicle Search server was added in AdminCenter with the correct email credentials to the FLIR Cloud.  
   • The specific camera was selected and saved as an “Analytics Camera” under Analytics Camera Selection.  
   • After saving the Smart Vehicle Search server with all relevant details, it appears as “Online” in the AdminCenter physical tree.  
3. In ControlCenter under Tools → Options, after expanding the OSD node, the “Show metadata OSD” checkbox is selected.  
4. When right-clicking the tile, confirm that “Enable Metadata OSD” is selected |
Too many triggered alarms may negatively affect the system. Moreover, monitoring a large number of alarms can also become unmanageable. Consider enabling the Automatic Clearing of alarms or increasing the Rearm threshold or selecting the Rearmed after previous alarm is cleared option. These settings will help in preventing the analytics alarms from flooding the system.

In case your system is overwhelmed with too many alarms, which negatively affect your system, please contact FLIR’s Latitude VMS Support Group (Product.Enterprise.Support@flir.com) for help to clear open alarms.